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Introducing Scanning and ASCII Transfer

Overview

You can enter data into Win School using Scanning or ASCII Transfer. Use
the Scanning module to read scan forms to import attendance, marks, or
course requests into Win School.

Use the ASCII Transfer module to import data from another program into
Win School, such as from a spreadsheet application. You can also use
ASCII Transfer to transfer data between schools.

Getting Technical Support

Chancery’s support programs are available by subscription and include the
below services.

Technical Support solves problems and answers questions when
software doesn’t produce the expected results.

Monday to Friday, 5 am to 5 pm Pacific Time
phone: 1-800-688-9939
fax: 1-800-346-0643
email: techsupp@chancery.com
website: http://support.chancery.com

Web support Chancery’s website includes a searchable
knowledge base with frequently asked questions,
tips, and troubleshooting, as well as support
forums for users to share experience and
knowledge. Web tutorials are available on an
annual subscription basis.

Software updates releases of new versions with improved functions
and software fixes. Updates are provided free of
charge for 3 months from your date of purchase
and are included in the subscription to Chancery
Support Programs.

For more information on Technical Support Programs, call Chancery
Customer Service at 1-800-999-9931 extension 130.

Providing Feedback

To improve the quality of your documentation, we would like your
comments regarding this guide. Email comments to Chancery’s User
Education department at user_docs@chancery.com.
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Using Scanning

Overview

Use Scanning to import data into your Win School database with an optical
scanner and paper forms. Only optical scanners work with the scan forms,
not digital scanners.

Use Scanning to import the following information:

• Either once or twice daily. To scan class attendance, classes must Daily
attendance, by class or homeroom. Scan in class attendance by period,
and homeroom attendance be scheduled with Scheduler.

• Marks, by class or by student.

• Course requests. Scan in course requests if classes are scheduled with
Scheduler.

This section provides terminology and concepts used in scanning, followed
by procedures for scanning attendance, then marks, then course requests.

What You Should Already Know About Scanning

To use the Scanning module, you need a basic understanding of the
following:

��A form file is a software file. A scan form is a paper form that a
scanner reads into the Scanning module according to instructions in the
form file.

��Entering data on scan forms, and inserting scan forms correctly in the
scanner.

��Operating and configuring your scanner, including how to connect your
computer and scanner, and how to define the communication settings
for the scanner.

��The meaning of: baud rate, parity, stop bits, data bits, and serial port.

��Attendance terminology for scanning attendance data.

��Scheduling terminology for scanning course requests.

��Report card terminology for scanning marks.

If you are unfamiliar with your scanner, read its operating manual. If you
are unfamiliar with terms or features used by other Win School modules,
read the guides for those modules.
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Processing Scan Forms

You follow a different procedure for each of the 3 types of scanned
information: attendance, marks, student requests.

In each procedure, the stages of the process are:

• create a form file

• print the form

• distribute copies of the form to teachers or students, who mark it and
return it to you

• run the marked forms through the scanner, which translates it into data
that Scanning can read, then saves it in the Win School database

The form file defines the type of data, scanner, and scan form for a
scanning job. When you create the form file, you define Win School codes
to correspond with the bubble marks on the scan form.

• Create 1 form file for each scanning job. Only 1 form file opens at a
time.

• Scan data only to the computer where you created the form file.
Scanned data is stored in a separate folder located on the hard drive.
See “Backing Up Data in the Scanform Folder” on page 4.

Use form files only with the Win School database for which they were
created. Do not use form files created with 1998 data for 1999 data, for
example. Create new form files for 1999.

Displaying Information for Scanning

The Main window has 6 icons that allow you to display lists of items, such
as classes or students, for scanning.

If icons are dimmed, it means a form is open. From the File menu, choose
Close to close the form and make the icons available.

Click To display To scan

Forms Form files list n/a

Classes Classes by term Attendance by period

Rooms Homerooms Daily or twice-daily
attendance
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Click To display To scan

Students
This icon is dimmed if course
numbers are not numeric or
unique, and if student
numbers are not numeric.

Students Course requests

Marks Classes by term Marks

By Students Marks

To open and close forms:

1 In the Main window, click the Forms icon.

2 Double-click a form name to open it. A checkmark in the Status
column indicates a scan form has been printed for the item.

3 To close the form file, choose Close from the File menu.

To display rosters:

1 Double-click a class or homeroom in the Main window to open a roster
window with a list of students.

2 Click the Class icon to list the students currently in that class or
homeroom, based on student timetables in Scheduler or homeroom
assignments in Details.

 Click the Form icon to list the students who were in the class when its
scan form was printed. The students are listed in the order in which
they were printed on the scan form.

 Click the Comparison icon to list all students who are in the Class
Roster or the Form Roster.

3 If a student is in the class roster, a checkmark appears in the In Class
Roster column.

 If the student was enrolled in the class when the scan form was printed,
a checkmark appears in the In Form Roster column.

Backing Up Data in the Scanform Folder

Scanning saves form file data to the Scanform folder. At installation,
Win School automatically creates the Scanform folder in the Win School
folder on the hard drive.

Manually back up the Scanform folder on a regular basis. Backing up the
data folder does not back up the Scanform folder. Back up the Scanform
folder separately.

• Scan data from the same computer you used to create your form files,
because the Scanform folder is stored on that hard drive.
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• Leave the Scanform folder on your hard drive. Do not move it to a
shared folder on a network server. Form files are not designed for
multi-user applications.

• Use form files only with the Win School database with which they
were created.

• Create form files for each database you use.

Deleting Form Files

Delete unwanted form files to free up disk space and to better manage files.

When a file is deleted, the scan forms created from the file cannot be used
again. Before deleting a form file, ensure you have scanned in all data.

To delete a form file:

1 In the Main window, click Forms to display a list of all forms files.

2 Select the forms to be deleted.

3 From the File menu, choose Delete Form File.

Filling in Scan Forms

• Use a soft lead pencil to fill in bubbles. A number 2 pencil is
recommended. Scanners are light sensitive to the graphite in pencils,
not to other materials.

• Erase changes and stray marks completely.

• Do not fold scan forms. If a form is creased, you can flatten it out and
attempt to scan it. If it doesn’t scan successfully, enter its data
manually, or complete a new scan form.

Replacing Lost, Spoiled, or Outdated Scan Forms

You may need to replace a scan form if it is lost or unreadable, or if its
roster is out of date because of timetable changes.

To check the scan form:

1 To check whether scan forms are accurate, open the form file.

2 From the Scan menu, choose Verify Scan Forms.

3 If you get a message that class information has changed, compare the
scan form roster with the current class roster. Double-click a selected
item, then click Comparison.

 Replace the scan form if the differences are significant.
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Replacing a Scan Form

If you need to replace a scan form, follow the procedures for printing scan
forms, using either the Print Scan Forms or Reprint Old Scan forms
commands from the Scan menu.

• To print a scan form with an up-to-date class roster, choose Print Scan
Forms from the Scan menu. Do not scan data from the old scan form.

• To print the most-recently printed version of the scan form, even if it
does not have the latest class roster, choose Reprint Old Scan Forms
from the Scan menu. If you find the old scan form later, you can use it.

Setting Up Scanning

Setting up involves 2 tasks:

❏ checking that Win School data used for scanning is correctly entered
and up-to-date.

❏ checking that communication settings for the scanner and the Scanning
module match.

Depending on how frequently you scan data and change scan forms or
scanners, do these tasks once, or each time you scan data. You can scan
attendance data daily using the same scanner and form, for example, or you
can scan course requests once a year, using a different scanner and form
each time.

Setting Up in Other Modules to Prepare for Scanning

Check that the following data is correctly entered in each Win School
module.

School Setup

❏ Set Scheduler Terms

❏ Timetable Structure
For attendance taken by class, or by homeroom twice-daily.

❏ Attendance Structure

❏ Daily Attendance Codes
For attendance taken by homeroom, once a day.

❏ Period Attendance Codes
For attendance taken by class, or by homeroom twice-daily.

❏ Daily Calendar

❏ Report Card Bins

❏ Course Numbers
Select the Unique and Numeric options to scan course requests.
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❏ Student Numbers
Select the Numeric option to scan course requests.

Details

❏ Course Name

❏ Course Number

❏ Show in Attendance

❏ Show in Report Cards

❏ Teacher Name

❏ Teacher Number

❏ Teacher’s Homeroom
For attendance taken by class.

❏ Student Name

❏ Student Number

❏ Student’s Homeroom
For attendance taken by homeroom.

Scheduler and Report Cards

❏ To scan attendance by class, schedule classes in Scheduler.

❏ To scan marks based on classes, create classes in Scheduler or Report
Cards.

Configuring Your Scanner and the Windows System

Make sure your scanner and the Scanning module can communicate. The
communication settings must be identical in these 3 areas:

• The scanner used to scan data

• The Windows system running Win School

• The Scanning module

Determining the Correct Communication Settings

Communications settings include: baud rate, parity, stop bits, data bits, and
the serial port. To determine what the settings should be:

• Use the settings listed in the manual that comes with the scanner.

• Use the default settings displayed in the Scanner Setup dialog in
Scanning. The first time you start Scanning, the factory settings for
each scanner Win School supports are listed in this dialog.
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To configure Do this

Your scanner Follow the instructions in the manual that comes with
the scanner.

Your operating
system

In the Control Panel, find the dialog that lists the
communications settings for the port you are using and
enter the correct settings.

The Scanning
module

Start Scanning. From the Scan menu, choose Scanner
Setup. From the popup menus, select the scanner and
form you are using. Default communication settings
for that scanner are displayed.

Scanning Attendance

Scan attendance by homeroom or by class.

• homeroom attendance is taken once a day or twice-daily

• class attendance is taken in the period that class occurs

• you can scan either twice-daily attendance or class attendance, not both

If you scan a class that is scheduled over more than 1 block, the students
get 1 attendance code for the multiple blocks. Multiple-block classes with a
single letter block are treated as 1 period and are assigned 1 attendance
code.

Stage 1: Creating an Attendance Form File

The form file defines the type of data, scanner, and scan form, and which
attendance codes correspond to the bubble marks on the scan forms.

To create a form file:

1 In the Main window, click Forms, or close open form files.

 To scan attendance by homeroom, click Rooms.

 To scan attendance by class, click Classes.

2 From the Scan menu, choose Scanner Setup, and from the top 2 popup
menus, select a scanner and a scan form.

 Make sure that the communication settings are the same as those
selected for the scanner, then click OK.

3 From the Scan menu, choose Form Setup.

 The information in the Form Setup dialog varies depending on the scan
form selected, and on selection of Rooms or Classes. Settings in the
checkboxes can affect values in the popup menus.
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 Select Print Student Numbers on form to print student numbers on the
scan form.

 Select Use Semi-Daily Attendance (AM/PM forms) to take attendance
twice daily. Two scan forms are printed for each homeroom: 1 for
morning attendance, the other for afternoon attendance. This checkbox
only appears when scanning homeroom attendance.

 Select from the popup menus for the bubble combinations on the scan
form, then click OK.

4 If you are scanning attendance by class, select the term from the menu
under the icons.

 If you are scanning attendance by homeroom, go to the next step.

5 From the File menu, choose New, type a file name and description,
then click OK.

 If the form setup is correct, click OK.

6 In the Assign Attendance Dates dialog, select dates to scan attendance,
then click OK.

 The new form file is listed in the Forms view.

Stage 2: Printing Attendance Scan Forms

Print a sample form to check for alignment errors, correct the errors, then
print the scan forms.

To print a scan form:

1 Load the scan forms into your printer.

2 In the Main window, open the form file you want to print.

3 Select items, such as classes or homerooms, for scan forms printing.

4 Sort the selected items in the order you want to print them.

5 From the Scan menu, choose Print Scan Forms, then select the “Sample
form to test printer alignment” and “Automatically” radio buttons.
Click OK to display a sample scan form.

6 From the System menu, choose Print. Check alignment.

 If the scan form is aligned correctly, close the displayed sample.

 If you’re printing from a laser printer, use Win School margin settings
as a guide. In the Shell, choose Margin Setup from the System menu
and check the settings.

7 In the Scanning module, choose Print Scan Forms from the Scan menu,
then select “Scan forms for actual use.”

 If the form ID bubbles are not aligned accurately in the sample forms,
select “Manually (by pencil).”

8 From the System menu, choose Print. Then close the window.
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In the Main window, a checkmark in the Status column indicates a scan
form has been printed for that item. If a homeroom or class selected for
printing has no students, no scan form prints and no checkmark
appears.

Stage 3: Completing Scan Forms for Attendance

To complete attendance scan forms:

1 Distribute the forms for attendance with instructions to the teachers on
which attendance codes correspond to the bubble marks on the scan
form. This was defined in “Stage 1: Creating an Attendance Form File”
on page 8.

 See “Filling in Scan Forms” on page 5 for general information. The
following points are specific to attendance:

• If a student is no longer in the class but is still listed in the roster,
leave the student’s bubbles empty. Do not cross out names.

• If a student has transferred into the class but is not listed in the
roster, enter attendance manually in the Attendance module, after
scanning is complete.

• If a week contains a holiday, or a class does not meet every day of
the week, leave the columns for those days blank. Do not use scan
forms for those days.

2 Collect completed scan forms and check that they have been filled
correctly.

Stage 4: Scanning Attendance Data

After scanning the forms, use the Attendance module to view the scanned
attendance data.

To prepare to scan the forms:

1 Make a backup of your Win School data, or check that a current one
exists. In case of problems, you can restore data from a backup.

2 Check that the scanner and scan form match the ones defined for the
form file. If they do not match, create a new form file and a new scan
form with the correct scanner and form type. Then redistribute the scan
forms.

3 Check that the scanner communication settings match those defined for
the form file. If the settings do not match, record the scanner settings so
you can edit the communication settings for the form file before you
scan the data.

4 Turn on the scanner and position the scan forms in the scanner. Insert
the scan forms in the correct direction.
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To scan Attendance data:

1 In the Main window, open the form file for the data to be scanned.

2 From the Scan menu, choose Scan Printed Forms.

 The Scanning Status icons show scanning progress.

Left-hand icon Scanning ready to begin

Second-from-left icon Scanning reading the form file

Third-from-left icon Scanning reading data stored in scanner

Right-hand icon Scanning writing data to Win School database

 Select Auto-Scan Forms to use a sheet feeder and scan all forms
without stopping. Deselect to scan forms 1 at a time.

 Select Stop on Scan Error to stop scanning when an error occurs.

3 Check the Setup Information.

 If the type of scanner and scan form are incorrect, click Close and
create another form file with the correct scanner and form type. Then
redistribute the scan forms to be marked again.

 If the communication settings do not match, click Edit Setup. From the
popup menus, select the correct settings, then click OK.

 An asterisk means a day is selected for scanning.

4 Click Edit Days to select days. Select “Replace Present Codes Only” to
reduce scanning time. Scanning only scans the codes for students with
a Present code in the Win School database, and assigns new codes if
necessary. Deselect to scan data for all students.

5 Click Scan to begin form feed. If you are scanning forms 1 at a time,
click Scan after inserting each form.

6 As scanning progresses, check the Scan Errors box for error messages.

 Click Stop to correct a problem and resume scanning, or find and re-
scan the form if necessary.

 To clear error messages, click Clear Errors.

7 To print error messages, click Close to close the Scan window, then
choose Scanning Error Listing from the Reports menu. The report is
displayed on your screen. Print the report, then reopen the Scan dialog.

8 When scanning is complete, click Close.
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To check the success of scanning:

1 Generate a form status report.

2 In the Attendance module, check that the scanned data is displayed
correctly.

3 If the scanning is not successful, check the error messages to correct
the problem, then re-scan the forms with errors.

Generating Form Status Reports
Open the appropriate form file.

• To check the status of forms in a form file, select the classes or
homerooms to report on.

 From the Reports menu, choose Form Status Report, select constraints,
then click OK. In the displayed report, N means not scanned, S means
scanned.

• To check the status of 1 class or homeroom in a form file, highlight a
class or homeroom with a checkmark in the Status column.

 From the Scan menu, choose Form Status.

 If you are scanning attendance twice daily, the status box displays
status information for either AM or PM forms. To show the status of
PM forms, choose Show ATD Status for PM from the Scan menu.
Deselect to show the status of AM forms.

Scanning Marks

You can scan marks by class or by student.

Do not change class rosters from the time you create the form file until you
scan marks. If you have to change class rosters, see “Stage 4: Scanning
Marks Data” on page 14.

Stage 1: Creating a Form File for Marks

The form file defines the type of data, scanner, and scan form, and which
letter grade, scores, and other codes correspond to the bubble marks on the
scan forms.

To create a form file:

1 In the Main window, click Forms, or close open form files.

 To scan marks by class, click Marks.

 To scan marks by student, click By Student.

2 From the Scan menu, choose Scanner Setup, and from the top 2 popup
menus, select a scanner and a scan form.
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 Make sure the communication settings are the same as those selected
for the scanner, then click OK.

3 From the Scan menu, choose Form Setup.

 The information in the Form Setup dialog varies depending on the scan
form selected.

 Settings in the checkboxes can affect values in the popup menus.

4 In the Value column, type up to 2 characters for marks or letter grades
corresponding to the bubble combination on the scan form.

 To specify whether the plus or minus sign is in front of or behind a
letter grade, click the letter grade.

 Select other options, then click OK.

5 Select a term from the popup menu below the view icons.

6 From the File menu, choose New, type a file name and description,
then click OK.

 If the form setup is correct, click OK.

7 Select the bins you want to scan marks into, then click OK.

 You return to the Main window and the name of the new file displays
below the icons.

Stage 2: Printing Scan Forms for Marks

Print a sample form to check for alignment errors, then correct the errors
and print the scan forms.

The procedure for printing scan forms for marks is the same as for printing
forms for attendance. See “Stage 2: Printing Attendance Scan Forms” on
page 9.

Tips for Printing Scan Forms for Marks

• Before printing, check the backup status of your Win School data.

• When selecting classes, we recommend you note which classes you do
not select. In case a problem occurs, Chancery Technical Support can
more easily recreate the necessary form files from your notes.

Stage 3: Completing Scan Forms for Marks

To complete the scan form:

1 Distribute the forms for marks, and instruct the teachers which letter
grades, scores, and other codes correspond to the bubble marks on the
scan form.

 You defined this in “Stage 1: Creating a Form File for Marks” on page
12.
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 See “Filling in Scan Forms” on page 5 for general information.

2 Collect scan forms and ensure they are completed correctly.

Marks Comment Field

Different scan forms allow you to enter 1 to 5 comment numbers. Some
forms list comment numbers from 1 to 36, making those comments
available to teachers, who may bubble up to 5 of these numbers in the
Comments field.

Other forms allow access to comments 1 though 999, but users can only
select 1 comment for each Comments field.

Marks Period Absent Field

Some forms allow you to enter the number of periods where the student was
absent from class. These fields list 0 - 9 in 1 row and 10 - 100 in the next
row. You can select 1 bubble per row.

Stage 4: Scanning Marks Data

After scanning the forms, use the Report Cards and Query modules to view
the scanned attendance data.

If a class roster has changed after printing and before scanning, choose
Verify Scan Forms from the Scan menu.

For new students:

• From the Scan menu, choose Print Scan Forms to print an updated scan
form. Fill out the new form and discard the old one.

 OR

• Scan the form to enter marks for the other students, then enter marks
manually for the new student.

To prepare to scan the forms:

1 Make a backup of your Win School data, or check that a current
backup exists.

2 Check that the scanner and scan form match the ones defined for the
form file.

 If they do not match, create a new form file and a new scan form with
the correct scanner and form type, then redistribute the scan forms.

3 Check that the scanner communication settings match those defined for
the form file.

 If they don’t match, record the scanner settings, so you can edit the
communication settings for the form file before you scan the data.

4 Turn on the scanner and insert the scan forms in the scanner.
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To scan Marks data:

1 In the Main window, open the form file for the data to be scanned.

2 From the Scan menu, choose Scan Printed Forms.

 The Scanning Status icons indicate progress on scanning the form:

Left-hand icon Scanning ready to begin

Second-from-left icon Scanning reading the form file

Third-from-left icon Scanning reading data stored in scanner

Right-hand icon Scanning writing data to Win School
database

Select “Auto-Scan Forms” to use a sheet feeder to scan forms without
stopping. Deselect to scan forms 1 at a time.

 Select “Stop on Scan Error” to stop scanning if an error occurs.

3 Check the Setup Information.

• If the type of scanner and scan form are incorrect, click Close and
create a new form file with the correct scanner and form type. Then
redistribute the scan forms.

• If the communication settings do not match, click Edit Setup. From
the popup menus, select the correct settings, then click OK.

4 Click Scan to begin form feed. If you are scanning forms 1 at a time,
click Scan after inserting each form.

5 As scanning progresses, check the Scan Errors box for error messages.

 Click Stop to correct a problem and resume scanning, or find and re-
scan the form if necessary.

 To clear error messages, click Clear Errors.

6 To print error messages, click Close to close the Scan window, then
choose Scanning Error Listing from the Reports menu. The report is
displayed on your screen. Print the report and reopen the Scan dialog.

7 When scanning is complete, click Close.

To check the success of scanning:

1 To check for forms not scanned, generate a form status report. See
“Generating Form Status Reports” on page 12.

2 In Report Cards or Query, check that the scanned data displays
correctly.

3 If scanning is not successful, correct the problem, then re-scan the
forms with errors.
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Scanning Course Requests

Scan forms for course requests have bubble combinations for course
numbers. Students fill in their student numbers and the numbers of the
courses they want. You don’t need to print scan forms, just scan the
completed forms.

Stage 1: Checking the Scan Form for Course Requests

Check that the course request scan form is correct for the scanner. If
completed scan forms are incorrect, have teachers and students bubble in
requests again on the correct forms.

To check that the scan form is correct for the scanner:

1 In the Main window, choose Scanner Setup from the Scan menu, then
select your scanner from the first popup menu.

 If you have not adjusted the default settings, the second popup menu
displays the form number to be used with that scanner.

2 Check your scanner manual to be sure the settings are correct.

Stage 2: Completing Scan Forms for Course Requests

The following points are specific to filling in scan forms for course
requests. For general information on filling in scan forms, see “Filling in
Scan Forms” on page 5.

• Some course request scan forms have G and L next to the course
number.

 G means global alternate. If G is filled in, the course can be substituted
for any course the student can’t get into.

 L means linked request. If L is filled in, the course can be substituted
only if the student cannot get into the course to the left of the linked
alternate course on the scan form.

• If the first course on the line on a scan form is a linked alternate, it is
linked to the last course on the previous line.

• The first course on the scan form cannot be a linked alternate, because
there is no previous course. If, in error, the first course is bubbled in as
a linked alternate, Scanning treats the course as a first choice request.
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Stage 3: Scanning Course Requests

After scanning the forms, use Scheduler to view the scanned attendance
data.

To prepare to scan the forms:

1 Make a backup of your Win School data, or check that a current one
exists. In case of problems, you can restore data from a backup.

2 Turn on the scanner and position the scan forms in the scanner. Insert
the forms in the correct direction.

To scan course requests:

1 In the Main window, close any form files that are open, then click the
Students icon.

2 From the Scan menu, choose Scanner Setup.

3 Select the scanner and scan form.

 Check that baud rate, parity, stop and data bits, and port are the same as
those selected for the scanner.

 If settings do not match, either change the settings on the scanner, or
change the settings in this dialog. Click OK.

4 From the Scan menu, choose Form Setup, select an option, then click
OK.

5 From the Scan menu, choose Scan Printed Forms.

 The Scanning Status icons indicate progress on scanning the form:

Left-hand icon Scanning ready to begin

Second-from-left icon Scanning reading the form file

Third-from-left icon Scanning reading data stored in scanner

Right-hand icon Scanning writing data to Win School
database

Select Auto-Scan Forms to use a sheet feeder and scan all forms
without stopping. Deselect to scan forms 1 at a time.

 Select Stop on Scan Error to stop scanning when an error occurs.

6 Check the Setup Information.

 If the type of scanner and scan form are incorrect, click Close and
create a new form file with the correct scanner and form type. Then
redistribute the scan forms.

 If the communication settings do not match, click Edit Setup. From the
popup menus, select the correct settings, then click OK.

7 Click Scan to begin form feed. If you are scanning forms 1 at a time,
click Scan after inserting each form.
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8 As scanning progresses, check the Scan Errors box for error messages.

 Click Stop to correct a problem and resume scanning, or find and re-
scan the form if necessary.

 To clear error messages, click Clear Errors.

9 To print error messages, click Close to close the Scan window, then
choose Scanning Error Listing from the Reports menu. The report is
displayed on your screen. Print the report and reopen the Scan dialog.

10 When scanning is complete, click Close.

To check the success of scanning:

1 To check for forms not scanned, generate a form status report. See
“Generating Form Status Reports” on page 12.

2 In Scheduler, check that the scanned data displays correctly.

3 If scanning is not successful, use the error messages to correct the
problem then re-scan the forms that have errors.

Scanning Alphanumeric Course Requests

You can scan alphanumeric course requests using the CSL-897 (Using
COL) scan form. You should make a backup of your Win School data so
that if there are problems, you can restore from a backup.

Scanning alphanumeric course requests includes the following stages:

1 Creating a form file.

2 Printing the Course Offerings List.

3 Distributing copies of the Course Offerings List and scan forms to
teachers or students who mark them and return them to you.

4 Running the marked forms through the scanner, which saves it in the
Win School database.

Stage 1: Creating a Form File

Using Scanners and Scan Form
You can connect the scanner to the COM1, COM2, COM3, or COM4 serial
port.

You must use the SS CSL-897 scan form made by Scanning Systems, a
division of Associated Business Products, Inc.

You can scan alphanumeric courses requests using the CSL-897 (Using
COL) scan form with any of the following scanners:

• NCS Opscan 2
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• NCS Opscan 3

• NCS Opscan 5

• Scanmark 2000 (no emulation)

• Scantron 8200 opt. 48

• Scantron 8400 opt. 48

• Sentry 3000 Optical Reader

• SR 360/601 (360 Mode)

To create a form file:

1 In the Scanning Main window, click Students.

2 From the Scan menu, choose Scanner Setup, and from the top 2 popup
menus, select a scanner and scan form as listed in “Using Scanners and
Scan Form.” Click OK.

3 From the Scan menu, choose Form Setup.

 If you have scanned course requests before, select whether you want to
append to the existing course requests or overwrite them. Click OK.

4 From the File menu, choose New. Type a name and description for the
new form file. Click OK.

 If the New command in the File menu is dimmed, check that the correct
scan form is selected and that Unique and Alphanumeric is selected in
Course Numbers in School Setup.

Stage 2: Printing the Course Offerings List

To print the course offerings list:

1 From the File menu, choose Print Course Offerings List.

 You can print a selected grade or subject, and sort by bubble number,
course number, or course title.

 Click OK to preview the Course Offerings List.

2 To print the list, choose Print from the System menu.

Stage 3: Distributing Course Offerings List and Scan Forms to Teachers

Distribute copies of the Course Offerings List and scan forms to teachers or
students to have them marked and returned. When the scan forms are
marked, you can scan them into Win School.
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Stage 4: Scanning Course Requests

When you have the marked scan forms, you can run them through the
scanner, which saves it in the Win School database.

To scan student course requests:

1 Check that the scanner and scan form are set up according to “Using
Scanners and Scan Form” and “To create a Form File:”, the scanner is
turned on, and the scan forms are inserted in the proper direction.

2 From the Scan menu, choose Scan Printed Forms.

3 In the Scan Student Course Requests dialog, make selections in the
Auto-Scanning Preference area, then click Scan to begin scanning.

Updating Course Offerings List

When there are changes to courses, you can update the Course Offerings
List.

To update course offerings list:

1 From the File menu, choose Update Course Offerings List.

2 Select Append new courses to the existing list or Regenerate the list.
Click OK.

3 If you select Regenerate the list, a warning dialog informs you that the
Course Offerings List will be regenerated and the bubble numbers
reassigned. Click OK to acknowledge the message.

Troubleshooting Scanning

Interpreting Error Messages

In the Scan Printed Forms dialog, the Scan Errors box displays error
messages for scanning forms which have not been completed properly, and
for errors in communication between the Scanning module and your
scanner.

Use the Scan Errors box to find the forms containing errors if:

• you did not select the Stop on Scan Error option

• no Auto-Scanning preferences are selected and an error occurs while
scanning

Click Clear Errors to delete the errors in this box.

If you want to print a copy of the errors listed in the Scan Errors box,
choose Scanning Error Listing from the Reports menu.
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Auto-Scan Forms Problems

When Auto-Scan Forms is selected in the Scan dialog, forms are scanned
continuously until:

• stop on Scan Error is selected and an error occurs

• the Scan Errors list is full

• the end-of-batch form is scanned

• you click Close

Scanning Error Listing Report

This report lists all the scanning error messages that appear in the Scan
Errors box in the Scan dialog.

The Scan Errors scrolling list is limited to 100 lines. When the list is full,
you cannot scan. At that time, you should either find the forms that
produced the errors and correct them, or print the errors and put the printed
list with the scanned forms that produced the errors.

Then reopen the Scan dialog, click Clear Errors, and resume scanning.

To print the Scanning Error Listing report:

1 From the Reports menu, choose Scanning Error Listing.

2 To print the report, choose Print from the System menu.

Error Messages in Scanning

There are 2 kinds of errors in Scanning: communication errors and form
errors. If Scanning cannot communicate with the scanner or make the
scanner scan a form, Scanning stops and displays a communication error in
the Scan dialog. If a particular form contains an error, a form error is
reported in the Scan dialog and scanning continues unless “Stop on Scan
Error” is selected.

If you do not see the error message you are looking for, contact Chancery
Technical Support.

Communication Errors

When errors in communication occur, no forms can be scanned. Scanning
automatically stops. Communication error messages are numbered in the
6000s.

Form Errors

Scanning also recognizes errors concerning how a form is bubbled. Form
errors halt scanning only if you do not select Auto-Scan Forms, or if you
select both Auto-Scan Forms and Stop on Scan Error. When Form errors
occur, check the form to determine the problem. You can correct and re-
scan it immediately, or set it aside to correct, and re-scan later.
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If Auto-Scan Forms is selected, but Stop on Scan Error is not selected, you
have to find the forms producing errors from the pile of scanned forms.
When an error is encountered, the form is identified by its form number (if
the number could be read) and its location in the pile of scanned forms.

Form error messages are numbered in the 7000s.

Scanning Error Messages

The messages are listed in numerical order.

Scanning Error 6000
Command error. Unknown command sent to the scanner.

Ensure you are using a scanner supported by Scanning. Also check that the
communication settings are identical in these three areas:

• your scanner

• the windows operating system you are using

• the Scanning module

Scanning Error 6002
The Hopper Release Lever is not in the Feed position.

Put the Hopper Release lever in the Feed position and try again.

Scanning Error 6003
Jam error. The scanner has a paper jam.

Remove all forms from the scanner, smooth any creased forms and try
again. If the error occurs again, one of your forms may be crumpled and
cannot be scanned. Either enter the data manually or create a new scan
form, fill it in, then re-scan the form.

Scanning Error 6004
Port is in use.

The communications port as selected in the Scanner Setup dialog is being
used by another hardware device. In the Scanner Setup dialog, select a new
port and try again.

Scanning Error 6006
There are no forms in Hopper to feed.

If you are auto-feeding scan forms, this error occurs when there is no end-
of-batch form (a batch form with an ID of zero). Click OK.

OR
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If there are forms in the Hopper, reposition them and try again.

See “Auto-Scan Forms Problems” on page 21.

Scanning Error 6007

Timing error. One or more timing marks were not read correctly.

The form was probably inserted upside-down or backwards. Try again with
the form correctly oriented.

Scanning Error 6020

Form is not of the proper type.

The scan form selected in the Scanner Setup dialog is not the same as the
scan form you are scanning. For example, an attendance form may have
been placed in a pile of grade forms. Remove the form from the pile and
continue scanning.

If you are using an Opscan 5 Model 30 scanner, set it to Sentry 3000
Emulation Mode and not Image Mode. In the Scanner Setup dialog in the
Scanning module, you can select either NCS Opscan 5 or Sentry 3000
Optical Reader.

Scanning Error 6021

Cannot configure port with selected communications settings.

The scanner cannot communicate with Scanning. Ensure that your scanner
configuration is correct. Confirm the communication settings in the Scanner
Setup dialog match your scanner’s settings.

Scanning Error 7100

Timeout. No data was received from the scanner.

Some, but not all, of the data was received from the scanner. Confirm that
the cable connecting the scanner to your computer is firmly attached.
Ensure that your scanner configuration is correct. Verify that the default
settings in the Scanner Setup dialog are accurately set.

If these settings were correct when the error occurred, you may have been
too slow in feeding the form. Try again.

Scanning Error 7101

Timeout. No data was received from the scanner.

Usually, this error occurs because you didn’t feed the scanner a form in
time. Try again.

If the problem persists, confirm that your scanner configuration is correct.
Ensure that the settings in the Scanner Setup dialog are accurate. Verify that
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the scanner cable is connected to the port selected in the Scanner Setup
dialog. Make sure the cable has no bent or broken pins, then try again.

Scanning Error 7102

The end of batch character was received.

This means scanning stopped because you pressed the End-of-Batch button
on the scanner.

Scanning Error 7104

The routine to process this form is not currently hooked up.

Make sure that a form name appears in the Setup Information box of the
Scan Printed Forms dialog. Use the Scanner Setup dialog to select the
correct scanner and form.

If the form name is the same as the form you are trying to scan, and you
receive this message, call Chancery Technical Support.

Scanning Error 7105

Could not set up scanner.

Confirm that the correct scanner is selected in the Scanner Setup dialog.
Make sure your scanner configuration is correct and the default settings in
the Scanner Setup dialog are accurate.

Scanning Error 7106

Please re-scan form (Form Count #).

Re-scan the form.

The Form Count number indicates the position of the error producing form
from the bottom of the pile.

Scanning Error 7502

The incorrect form was fed through the scanner (Count #).

First check that the form that produced the error is the kind that you want to
scan. A teacher might have returned a grades form among the attendance
forms, for example.

Next, confirm that the form file name on the scan form matches the Active
Form in the Main window. You may have the wrong file open. If you are
scanning requests, verify that the correct form is selected in the Scanner
Setup dialog.

The Count number indicates the position of the error producing form from
the bottom of the pile.
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Scanning Error 7505

Form ID # does not belong to the currently opened Form File (Form Count
#).

If the form belongs to the currently opened form file, confirm that the form
ID number printed on the form is correctly bubbled in the form number
bubbles or, on older forms, the course number bubbles. The marks filling in
the form ID number may not be dark enough for the scanner to read. Fill
them in completely and heavily.

The Form Count number indicates the position of the error producing form
from the bottom of the pile.

Scanning Error 7507

An error occurred while saving changes to the form status flag (Count #,
ID #).

The Status Information dialog is incorrectly stating that a form has not been
scanned. You can re-scan the form to display the correct status. However,
this is optional as the scan form has already been correctly scanned.

To access the Status Information dialog, from the Scan menu, choose Form
Status.

Scanning Error 7508

The end of form character was received too soon.

First, confirm that the form which produced the error is the kind you want
to scan.

Next, confirm that the form file name on the form matches the Active Form
in the Main window. You may have the wrong file open. If you are
scanning requests, check that the correct form is selected in the Scanner
Setup dialog.

Scanning Error 7509

The end of batch form was fed.

This is not an error message; it means that scanning stopped because an
attendance or grades form with an ID number of 0 was read. This is the
end-of-batch form and should be the last form in a batch when Auto-Scan
Forms is selected.

If the last form that was read is not your end-of-batch form, its form ID was
incorrectly read as 0. Darken all bubbles of the form ID and try scanning
the form again.
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Scanning Error 7510

Too much data was transmitted from the scanner.

First, make sure the form that produced the error is the kind you want to
scan. For example, a teacher might have returned a grades form among the
attendance forms.

Next, check that the form file name on the form matches the Active Form in
the Main window. You may have the wrong file open. If you are scanning
requests, verify that the correct form is selected in the Scanner Setup dialog.

Scanning Error 7513

An error occurred while reading a student’s letter grade (Count #, ID #).

A student’s letter grade is rejected if:

• more than one letter is bubbled

• both + and - are bubbled

• a pass/fail mark and either + or - are bubbled

Erase the extra marks completely and re-scan the form.

The Count number indicates the position of the error-producing form from
the bottom of the pile; the ID number is the form ID number.

Scanning Error 7514

An error occurred while reading a student’s Work Habit (Count #, ID #).

Ensure that no more than one bubble is marked in each student’s Work
Habit field. Erase all extra marks completely.

The Count number indicates the number of forms from the bottom of the
pile; the ID number is the form ID number.

Scanning Error 7516

An invalid Course Number has been bubbled (Count #, ID #), or the
number bubbled is not assigned to any course.

In any row or column that contains a number from 0 to 9, only one bubble
should be filled in. Make the necessary corrections, erasing old marks
completely, then re-scan the forms.

The Count number indicates the number of forms from the bottom of the
pile; the ID number is the form ID number.

Scanning Error 7517

An invalid Student Number has been bubbled (Count #, ID #), or the
number bubbled is not assigned to any student.
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In any row or column that contains a number 0 to 9, only one bubble should
be filled in. Make the necessary corrections, erasing old marks completely,
then re-scan the forms.

The Count number indicates the position of the error producing form from
the bottom of the pile; the ID number is the form ID number.

Scanning Error 7519

Both alternate (G, L) marks have been bubbled for a course (Count #, ID #).

Find any course that has both the G and L bubbles filled in. Erase one of
them completely, then re-scan the form.

The Count number indicates the number of forms from the bottom of the
pile; the ID number is the form ID number.

Scanning Error 7520

Invalid Form Number.

A form number has been incorrectly bubbled or has been scanned for the
wrong form file. Remember that any form number is incorrect for student
course requests. Make the necessary corrections, erasing the old marks
completely, then re-scan the form or place the form in the correct form file.

Scanning Error 7521

Both pass grade and letter grade have been filled (Count #, ID #).

Find any course that has both the pass grade and letter grade filled in. Erase
one of them completely, then re-scan the form.

The Count number indicates the position of the error producing form from
the bottom of the pile; the ID number is the form ID number.

Scanning Error 7522

An error occurred while reading a student’s percent grade (Count #, ID #).

Confirm that all students’ percent grades are bubbled in completely. Erase
any extra marks and re-scan the form.

The Count number indicates the position of the error producing form from
the bottom of the pile; the ID number is the form ID number.

Scanning Error 7523

An error occurred while reading a student’s Citizenship (Count #, ID #).

Confirm that no more than one bubble is marked in each student’s
Citizenship field. Erase all extra marks completely.

The Count number indicates the position of the error producing form from
the bottom of the pile; the ID number is the form ID number.



Win School Scanning and ASCII Transfer

28    Using Scanning  •  Troubleshooting Scanning

Scanning Error 7524

An error occurred while reading a student’s Pass Grade (Count #, ID #).

Confirm that no more than one bubble is marked in each student’s Pass
Grade field. Completely erase any extra marks.

The Count number indicates the position of the error producing form from
the bottom of the pile; the ID number is the form ID number.

Scanning Error 7525

Cannot process day # of Week # (Count #, ID #).

The day you are scanning attendance for has no attendance value, most
likely because it is a holiday. Click Edit Days in the Scan Printed Forms
dialog, deselect the day, and re-scan the form.

The Count number indicates the position of the error producing form from
the bottom of the pile; the ID number is the form ID number.

Scanning Error 7530

Link Course requires a Main Course (Form Count #, ID #).

Look for courses with the L bubbled. The course before it must have
neither the G or L bubbled. Erase the incorrect marks completely and re-
scan the form.

The Form Count number indicates the position of the error producing form
from the bottom of the pile; the ID number is the student’s ID number.

Scanning Error 7531

No courses filled for the student (Form Count #, ID #).

The student did not bubble the Course Request form, or did not fill in the
bubbles darkly enough. Fill in light bubbles heavily and completely.

The Form Count number indicates the position of the error producing form
from the bottom of the pile; the ID number is the student ID number.

Scanning Error 7533

Invalid Attendance Code

Find any student who has more than one code bubbled in on an
F-7411-CSL-L attendance form. Erase all extra marks completely, then re-
scan the form.

Scanning Error 9999

9999 Unhandled Scanning Error

This error message may also be accompanied by a number in brackets. This
number further defines where the error occurred in the Scanning module.
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Write down the entire error message on your screen and call Chancery
Technical Support.

Fixing General Problems

Finding scan sheets that need reprinting after making roster
changes
From the Scan menu, choose Verify Scan Forms.

Form IDs do not line up when printing scan forms on a laser printer
Try adjusting the Reduce/Enlarge option in Page Setup from the System
menu. Some laser printers and printer drivers use different margin settings
and need adjustment when printing scan forms.

Message “Course Requests will not be available. Student or
Course numbers are not numeric or Course numbers are not
unique”
Scanning course requests requires numeric student and course numbers in
School Setup.

Printing scan forms on a laser printer
Use a laser printer only for cut-sheet, not continuous-feed, forms.

Student icon dimmed in Main window
Scanning course requests requires numeric student and course numbers in
School Setup.

Using Scanmark 2500 scanner with Win School
Scantron has replaced its 8000 series scanners with the 2500 series. Select
the Scantron 8200 or 8400 scanner in Scanner Setup when using the
Scanmark 2500 series scanners.
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Using ASCII Transfer

Overview

ASCII is a code for representing English characters as numbers, with each
letter assigned a number from 0 to 127. ASCII codes are used to represent
text, making it possible to transfer data from one computer to another. It is
an acronym for American Standard Code for Information Exchange.

Use the ASCII Transfer module to import and export data. Some
Win School data can only be transferred with the ASCII Transfer module.

Common times to transfer data are:

• when installing Win School for the first time

 You can import data from another program, such as a spreadsheet
application.

• when students transfer between schools

 You can export or import student information.

If other modules are running, you can start ASCII Transfer, but you cannot
import data.

Deciding on Data-Transfer Methods

The table lists data transfer methods between Win School and other
programs. The modules used most frequently are ASCII Transfer, Scanning,
and Scheduler.

To transfer data with modules other than ASCII Transfer, please read the
sections in the guide for the particular module.

Module and Section in Guide Transferable Data Format

ASCII Transfer

System Administrator Guide,
ASCII Transfer section

Import and export student, teacher,
room, and course data.

Export student timetables.

Format defined by a template
you create. Provides many
formats and fewer fields than
Scheduler or Report Manager.

Scanning

System Administrator Guide,
Scanning Data section

Import course requests, daily and
class attendance, marks.

Format pre-defined by
Win School.

Scheduler

Data Transfer section

Import and export class and student
timetables. For an entire school,
include all classes or all students.

Format pre-defined by
Win School. Comma-delimited
format that cannot be changed.
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Module and Section in Guide Transferable Data Format

Universal Access, and
District Extract

Export student, teacher, school,
marks, attendance, and course data.

dBase Format (DBF).

Various modules and Report
Manager

Reports section

Export data in built-in reports.

Export data in custom reports.
Templates created in Report Manager.

Format pre-defined by
Win School. Gives more fields
than Scheduler or ASCII
Transfer.

Defining File Structure

All Win School data is stored in Win School files readable by Win School
only. To transfer data into or out of Win School as readable text, 3 steps are
required:

1 Create a template to export or import data.

2 Generate a transfer file containing a copy of your data, in text format.

3 Perform the data transfer.

To transfer data, be sure both Win School and the other program are
translating the information in the data file in the same way.

Data File Structure in Win School

Record A data file consists of a series of records. Each record contains data
about 1 item, such as 1 student.

Field Each record consists of a series of fields. Each field contains specific
data about 1 item, such as birthdate. Each field in a transfer file must have a
corresponding field in your Win School database.

Fields appear in a sequence which is repeated for each record. Win School
and the other program must agree on what fields are in each record and
where each field and record ends. There are 2 ways of defining this
information:

• Using fields and records with delimiters and surround characters.

• Using fields with fixed lengths.

Delimiters These define the beginning and end of a field and a record.
Delimiters can be commas, tabs, or paragraph marks. Record delimiters
mark the end of records, and field delimiters mark the end of fields.

Surround Characters These can be quotation marks. They are placed
around fields to distinguish between characters used as delimiters and text
characters.

Commas may be your field delimiters, but some addresses contain commas,
such as 313 North Street, Apt. 123. By enclosing the address field in
surround characters, “313 North Street, Apt. 123,” Win School transfers all
of that text into 1 field, instead of placing 313 North Street in 1 field and
Apt 123 in the next field.



Win School Scanning and ASCII Transfer

32    Using ASCII Transfer  •  Overview

Fixed Length This is a defined number of characters for each field and
record. For example, you can define the first 6 characters to be the student
number and the next 20 characters to be the student name.

Templates These define data type, fields, field order, and method of
defining field and record lengths. You must define the file structure with
templates in ASCII Transfer.

Data File Structure in Other Programs

Mainframe computer programs usually recognize quotation marks as
surround characters, commas as field delimiters, and return characters as
record delimiters. A pair of empty quotation marks indicate an empty field.

Many spreadsheet and database programs do not use surround characters.
They delimit fields with tab characters and records with return characters.

Saving Templates to Diskette

Copy a template to a diskette to give to other schools, or to copy to your
Win School database. You can include the template with the transfer file.

To copy a template to a diskette:

1 In the Main window, highlight the template you want to copy.

2 From the File menu, choose Save Template to Disk.

3 Type a name for the template. For easy identification, use the .CAT file
extension to indicate a catalog file. Click OK.

To copy a template from diskette to Win School:

1 In the Main window, choose Load Template from Disk from the File
menu.

2 Locate and highlight the template, then click OK.

3 In the dialog that appears, name the template and click OK. You can
keep the same name or give it a new one, but keep the .CAT extension.

 A copy of the template is saved to your Win School database and its
name appears in the Main window.
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Creating Templates

You must use templates to import and export data. Templates define the
data fields to transfer, their order, and where fields and records begin and
end.

Win School data transfer templates have the .CAT extension. Report
Manager templates have the .RMN extension.

Using the ASCII Transfer Windows

To open a template in the Main window, double-click it. The Edit Template
and Data List windows open.

Main Window
When either the Data List or the Edit Template window is opened, the Main
window closes.

To open the Main window, close the Data List window.

Edit Template Window
The Edit Template window is where you edit, add, and delete fields to a
new or an existing template.

Template Fields Lists the order of the fields on the template. The
order is important. It must match the order of the
fields in the transfer file.

Field Categories When you highlight a category, its fields are
displayed in the Field Palette list. The Main
category lists all available fields. The Template
category lists special file structure fields.
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Field Palette Lists the fields you can add to the template. The
list changes depending on the category in the
Field Categories list.

Data List Window

Export and import data from the Data List window.

The Data List window displays lists of 1 type of data, depending on your
template type. From these lists, select items to transfer when exporting or
importing.

You can sort students, courses, teachers, or resources data lists. Rooms,
home languages, conditions, or condition types are listed alphabetically.

Preparing to Create a Template

Find the file structure for the program to which, or from which you are
transferring data. For importing, you can open the transfer file in a word
processing program and look at the data to confirm this information.

You need to know the following:

• data fields and their order

• delimiters or fixed record lengths used

• format of dates and student names

• number of requests transferred when transferring student requests, if
the number varies, and if course names or numbers are used

Minimum Template Requirements

Order and number of fields must be identical for the Win School data
template and the sending or receiving program.

Student, Teacher, Course, and Room templates must include the record
number. For example, a Student template requires student numbers, a Room
template, room numbers.
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Include a minimum of both student name and student number in the
template when importing a new student record.

Creating a Template

Use the following procedure for creating a template. For more information
on fields, and the order in which to add them, see “Designing Report
Manager Templates” in the System Administrator Guide.

To create a template:

1 From the File menu in the Main window, select New Template.

2 Type the name of the new template in the Template Name field.

3 Select the type of template.

To Select

Import or export Details student information

Import or export Scheduler student requests

Export student timetables

Import or export Historical Marks

Export Scheduler course requests

Students (Details)

Import or export course information Courses (Details)

Import or export teacher information Teachers (Details)

Import or export room information Rooms (Setup)

Import home language lists Home Lang (Setup)

Import condition codes Cond Code (Setup)

Import condition types Cond Type (Setup)

Import or export course resources Resources (Details)

4 In the Edit Template window, choose Format Setup from the Edit
menu.

5 In the Format Setup dialog, define formats and delimiters for the
template, then click OK.
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 For more information, see “Designing Report Manager Templates” in
the System Administrator Guide.

6 Add fields to your template in the order you want Win School to
transfer data. See the following field descriptions for more information.

 For information on inserting repeating groups, see “Using Repeating
Groups” on page 41.

7 Check that your template is correct, then save it.

New Students

A template to import new students must include both the Student Name and
Student Number fields.

Address Fields for Students

A message appears if your template includes an address field that does not
appear in Details. You can proceed to transfer this data anyway, or you can
click Cancel to close the dialog without transferring data. Then delete the
address fields on your template.

The following address fields do not appear as separate fields in Win School.
You can import, but not export, them. During import, Win School appends
these fields to the appropriate Street Address field.

• Contact’s Apartment Number #

• Contact’s House Number

• Contact’s Street

• Student’s Address Apartment Number # Use when your Student
Address Format has 2 address lines in School Setup.

The order of the fields in the template determines the order in which the
data is transferred. For example, if the apartment-number field appears in
the template before the street address field, the apartment number will
appear at the beginning of the street address in Student Details.

When separate apartment numbers are imported, Win School separates the
numbers from the rest of the street address by a comma and a space.

If the prefixes Apt. or # are not included in the transfer file, add them in
Details after the import. If a template containing these fields is used for
export, an empty field appears in the transfer file where that field appeared
in the template.

Contact Fields

You can change the name of a contact field from one contact to another.
For example, Contact 1 can be changed to Emergency Contact 2.
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To change a Contact field:

1 In the Template Fields column, double-click the existing Contact
Name.

2 From the popup menu in the Select Contact dialog, select a contact,
then click OK.

Course Request Fields
Import either the “Course Request (Name)” or “Course Request (Number)”
field, not both. If you import both, each course request is imported twice. If
importing both fields is unavoidable, in Scheduler, delete duplicate requests
with “Remove Duplicate Requests.”

You can export both “Course Request Name” and “Course Request
Number” fields.

The name and number fields transfer first-choice course requests. To import
alternate requests, add the “Course Request Kind” field right after the name
or number fields.

Use Course Request Kind to transfer alternate course requests. It must
follow the Course Request field.

If the imported data begins with L, the preceding course request becomes a
linked alternate. The linked alternate must follow the first-choice request
with which it is linked. If the imported data begins with G, the preceding
course request becomes a global alternate. If the imported data begins with
any other character or is empty, the preceding course request becomes a
first-choice request.

Course Request Linked Alternate fields contain an alternate request linked
to the preceding course request. A Course Request field must precede a
Course Request Linked Alternate field.

Course Request Global Alternate fields are for global alternate requests.

Dummy Field
In the Template field category, this is the first field in the Field Palette
column.

When exporting data, place dummy fields in the position where the
program receiving your data requires data fields that Win School does not
have or that you want to leave empty.

When importing data, insert dummy fields in the position where the import
file has a data field that you don’t want in Win School.

Gender Field
When exporting data, Win School transfers student and teacher gender
fields as Male and Female. When importing, Win School transfers any data
in this field beginning with f or m as Female or Male.
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Fixed Length Fields

When importing a fixed length file that includes record delimiters, end the
template with a Dummy field the same length as the record delimiter,
usually 1 or 2 characters. Otherwise, the number of characters in the
template will not match the number of characters in each record of the
transfer file.

Fixed length fields are left justified. If the data in a fixed length field uses
fewer characters than the number assigned to that field, insert spaces as fill
characters. If a field length is 10 characters, for example, and the data is
only 8 characters, add 2 spaces to the end of the data.

Historical Data

When transferring data, include Historical data in a repeating group. From
the Edit menu, select Define Repeating Group. Put Year and Class fields in
repeating groups. If you don’t do this, the data won’t transfer.

For example, set up fields on a template, in order:

• Student Number

• Repeating Group * times

• Year

• School Name

• Student Grade

When you export historical data for the 1998/99 school year, 1998 appears
in the Year field.

When you import historical data, the Year field for the 1998/99 school year
should be 1998, not 1999.

In Terms Field

The “In Terms” field in a student historical record is represented by a Y or
N. The field is position sensitive, to represent the 12 terms. If the class is
taught in Term 2, the data element in the ASCII file is:
NYNNNNNNNNNN.

Name Field

Win School can transfer student or teacher name fields as 1 field or as
separate fields.

Use the fields Student’s Name or Teacher’s Name, to transfer the first,
middle, and last names in 1 field. Use the fields Name (First), Name
(Middle), and Name (Surname), to transfer names in separate fields.

The Student’s Name and Teacher’s Name fields operate as follows:

• When exporting the Student’s Name or Teacher’s Name in 1 field,
Win School transfers the first, middle, and surnames in the order
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specified in the Format Setup dialog, in the Edit menu. If the surname
is first, a comma is inserted after the surname before the first and/or
middle names.

• When importing the Student’s Name or Teacher’s Name in 1 field,
Win School transfers the first word as the first name, the second as the
middle name, and all other words as the last name. If a name element is
missing, Win School leaves the middle name blank.

After importing, check student names in Details for accuracy. When
importing, commas in the name are removed.

School Setup Lists for Popup Menus

Data for School Setup is transferred as a pair: Short Code and Description.
Templates transferring School Setup lists must include the pair.

If imported Short Codes match Win School codes, but imported
Descriptions don’t match, Win School uses existing Descriptions, not the
imported ones.

If Short Codes don’t match but Descriptions do, Win School applies
existing Short Codes to the imported Descriptions.

If neither Short Codes nor Descriptions match, and you select the checkbox
in the Setup column in the Edit Template window, Win School adds the
imported Short Codes with Descriptions to School Setup. The new Short
Code is either the imported code if it is 4 characters or less, or a greater-
than symbol followed by 3 digits, for example >005. You can change this
Short Code in School Setup.

Status Codes

Imported Status Codes must include a date: Student’s Status Code and
Student’s Status Code Date.

When importing student records which have new status codes, either:

• Before importing, in School Setup, enter new status codes.

 OR

• After importing, change the status-code type in School Setup.
Win School adds all new status codes in School Setup as Entry type.
Student status codes are automatically updated in Student Details.

Timetable Fields and Repeating Groups

The number of loops in the repeating group of exported Student Timetables
must be: blocks-in-a-cycle times terms-in-the-year. In Scheduler, this
number appears in the heading of the Student Usage list in the Performance
Report.
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To export Timetable fields, include at least 1 of the following fields in the
repeating group:

• Class Number (export only)

• Class Name (export only)

• Class Grade (export only)

• Class Section (export only)

• Course Alternate Name (export only)

User-Defined Fields and Flags, and Custom Tabs fields

User-defined fields and flags are identified only by number in the Field
Palette column. Check School Setup to select the correct fields for a
template.

User-defined flags have Yes and No values. Win School interprets imported
y or n, upper or lower case, as Yes or No.

Custom Tabs fields defined as Boolean accept Yes or No, and are not case-
sensitive. Blank fields are imported as N/A.

User-Defined (Export Only) Fields

These fields allow insertion of any ASCII character in the exporting
transfer file. Use this field anywhere as often as you like in your template to
export characters you specify.

To select a character for the User-Defined (Export Only) field:

1 In the Edit Template window, highlight Template in the Field
Categories column, then double-click the “User-Defined (Export
Only)” field in the Field Palette column to copy it to the Template
Fields column.

2 Double-click “User-Defined (Export Only)” in the Template Fields
column, then select the character you want added to the template.

 For ASCII, type the character’s ASCII number between 0 and 255.

Using Format Setup Options

Use the Format Setup dialog to select field delimiters and format options
for exporting or importing data.

From the Edit menu in the Edit Template window, Select Format Setup.

Record Delimiter, Field Delimiter, and Surround Character

You only need to select these options if you are not using fixed length
records. If you are using fixed length records, see “Use Fixed Record
Lengths” on page 41.
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The record delimiter, field delimiter, and surround characters must be
different from one another. The surround character must also be different
from any other character you select in this dialog.

LF line feed

CR carriage return

ASCII the ASCII value of the character you want. ASCII
values above 128 are not standard.

Date Delimiter

The character that separates day, month, and year. None means each
element of the date must be represented by 2 digits, for a total of 6 digits.
For example, 010699 is January 6, 1999.

Date Format

Choose the order of the day, month, and year for dates. The year can use 2
or 4 digits. The month can use 2 digits or 3 characters.

Name Format

Choose the name order for transferring the Student Name and Teacher
Name fields.

Use Intelligent Surround

For exporting data only and only for fields where the checkbox in the
Surround column in the Edit Template window is not checked. Ignored
when importing data.

When “Use Intelligent Surround” is selected, each field in each record is
checked to see if it contains a field or record delimiter character. If a field
does, ASCII Transfer places surround characters around that field, so that
the delimiter characters within the field are not interpreted as file delimiters.

Use Fixed Record Lengths

If you use fixed record lengths instead of delimiters, Win School disregards
all format options except date format. Win School treats all characters in a
field as text. The numbers in the Length column in the Edit Template
window determine where fields and records begin and end.

Using Repeating Groups

The Field Categories  icon in the Edit Template window identifies fields
that are often included in repeating groups. Use repeating groups to transfer
data in fields that contain more than 1 value. A student usually requests
more than 1 course, for example, so the Course Request field is usually set
up in a repeating group.
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Course requests, status codes, conduct fields, and student timetable blocks
are fields commonly used in repeating groups. Historical information fields
must be included in repeating groups to transfer successfully.

Templates can contain more than 1 repeating group.

Using Loops in Repeating Groups

Loops are the number of times Win School transfers data for a field. When
you create a repeating group, you define the number of loops, which is the
maximum number of values a field can contain.

If students can have up to 3 status codes for the status field, for example, set
3 loops. Students with fewer than 3 codes will have empty status code
fields.

To be sure there are enough loops, set the number slightly higher than you
need.

Creating and Editing Repeating Groups

Define the number of loops, then define the fields to be included in the
repeating group. The order of the fields is important. Win School transfers
data in the order the fields appear in this list.

To create a repeating group:

1 Open the template in which you want to create a repeating group.

2 In the Template Fields column, highlight the field above which you
want to insert the repeating group.

3 From the Edit menu, choose Define Repeating Group.

4 Type a number in the Number of loops field, then click OK.

 Make the number of loops equal to or more than the maximum number
of values stored by any field in the group. Two entries appear in the
Template Fields column.

 

5 Highlight End Group, then, in the Field Palette column, double-click
the field you want included in the repeating group. The field is inserted
above End Group in the Template Fields column.

6 Repeat Step 5 for each field you want to include.

7 Save the template.

To change the number of loops:

• In the Template Fields column, double-click Repeating Groups * times
for the group you want to change the number for.
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To delete a repeating group:

• In the Template Fields column, highlight the Repeating Groups * times
field you want to delete and press Delete, then click Yes to delete it.

Editing a Template

To add fields to a template:

1 In the Main window, double-click the template you want to edit.

2 In the Field Categories column, highlight the category that contains the
field you want to add.

3 In the Field Palette column, double-click a field to add it above the
highlighted field in the Template Fields column.

4 If you are not using fixed length fields, go to the next step. If you are
using fixed length fields, type the length of each field in the Length
column.

 If the fixed length field is smaller than the default value, imported data
is not affected, exported data might be truncated.

 If the fixed length field is larger than the default value, imported data
might be truncated, exported data is not affected.

5 If you are not importing School Setup lists, go to the next step. If you
are importing School Setup lists that correspond to popup menus in
Details, a checkbox appears in the Setup column. When exporting data,
these checkboxes are ignored.

 Specify what happens to data that doesn’t match an existing item in a
popup menu.

• To add a field to the popup menu, select the Setup checkbox. The
> symbol will appear in School Setup and Details popup menus. In
School Setup, you can delete the symbol.

• To not import a field, deselect the Setup checkbox. N/A will
appear in the student, teacher, and course popup menus.

6 If you are not exporting data, go to the next step. If you are exporting
data, select the Surround checkbox to place surround characters around
that field. When importing data, this checkbox is ignored.

7 Save your template.

To delete and rename templates:

• To delete a template, in the Main window, highlight the template you
want to delete and select Delete Template from the File menu. Click
Yes.

• To rename a template, highlight the name, choose Rename Template
from the File menu, and type the new name. Click OK.
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Exporting Data

Before exporting data, check that your template is up-to-date. Exporting
data copies selected data in the format specified by the template from
Win School to a transfer file.

To export data:

1 In the Main window, double-click the export template.

2 In the Data List window, select the items to export.

3 From the Import/Export menu, select Export.

4 Type the name of the transfer file. Locate and highlight the folder that
the transfer file is to be saved to, and click OK.

5 Print the Export Report, then close the Report window.

6 Check that the export is complete and without errors.

• Review the Export Report. If there are errors, correct them in the
originating file and repeat the export.

• If the export is successful, load the data from the transfer file to the
program importing it, then check for errors.

Importing Data

Importing data is a 4-stage process:

• preparing to Import Data

• making a Trial Import

• importing Data

• checking and correcting Imported Data

Preparing to Import Data

Always back up your data before importing. If the data is imported
incorrectly, you have the option of restoring from a backup.

When you import Grade Points with blank Potential Credits, the default
Potential Credit is 1 after the import. This provides correct GPA
calculations.

To prepare to import data:

1 Back up your Win School data.

2 Check that the importing template is up-to-date.

3 Check that all popup menus are complete in School Setup.



Win School Scanning and ASCII Transfer

Using ASCII Transfer  •  Importing Data    45

4 In the program from which you want to transfer data, copy the data in
text (ASCII) format to a transfer file. The documentation for that
program should describe the procedure.

5 Put the transfer file on a computer or server accessible from the
computer running Win School.

6 If you are importing data from another school, do a trial import with a
few students so you can check that the data imports correctly. See
“Making a Trial Import” on page 45.

Before Importing User-Defined Fields

Before using ASCII Transfer to import User Defined data, make sure the
receiving fields have the correct field type in School Setup.

User Defined fields can have 1 of 4 Types: Text, Numeric, Date, or Phone.
Extended Demographics fields can have a Boolean type in addition to the
above 4 types. Boolean fields have Yes, No, or N/A values. Blank fields are
imported as N/A.

If you try to import alphanumeric data into a User Defined field defined as
Numeric, that field won’t accept the data and it is not updated.

If you want to change an incorrect User Defined field type after data has
been entered, use ASCII Transfer to export the data, correct the field type,
then re-import the data.

For example, if the User Defined field was set to Numeric, you cannot enter
alphanumeric data. Use ASCII Transfer to export this data, change the field
type to Text, and use ASCII Transfer to import the data back. The data is
now seen as text, allowing letters and numbers in the field.

Making a Trial Import

The trial import generates a report, but does not import data. It neither
affects Win School data nor the data in the transfer file.

Do a trial import to ensure that the transfer file structure matches the import
template structure. Check that fields are in the correct order and contain the
correct data.

Trial Import Report

The trial import creates a report on the template format, the fields in the
template, and data from the transfer file.

To do a trial import:

1 Open the Data List window of the template you are using to import
data.

2 From the Import/Export menu, select Import Trial, highlight the
transfer file, then click OK.
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3 Enter the number of records to import. A minimum of 2 are required to
verify the end of 1 record and the start of the next.

4 The first page of the Trial Import report shows the format of the
template. To view the template fields and imported data, display the
remaining pages.

5 Print the Import Trial report and check for inconsistencies between the
transfer file and the template. Look for a 1-to-1 correlation between
data fields in the transfer file and data fields in the template. See
“Checking and Correcting Imported Data” on page 48.

6 Correct problems by making changes to either the template or the
transfer file.

 If there are just a few errors, edit with a word processor. Use the Save
As command to save in Text Only format.

 For many errors, correct in the program that exported the file, then
create a new transfer file.

7 Repeat the trial import until you are satisfied.

Checklist for Trial Import

Check that delimiter and format preferences are correct. These preferences
are defined in the Format Setup dialog and displayed on the first page of the
Trial Import report.

��Check that delimiters are correct. If all imported data appears in 1 field,
field delimiters are incorrect.

��Check dates format.

��Check names format.

��Check that course requests are either names or numbers, not both.

��Check that data is imported into the correct fields, in the correct order,
using the correct number of fields. Check several records.

��Check that data displayed on each line corresponds to the correct field
name.

� If data appears in the wrong field, see if the problem is with the
template or with the transfer file.

��Check the values for Yes/No flags.

��Check that all data fields appear for all students.

If a student’s fields are blank or the record stops, find out why. The
student might not have any data for those fields. Or a record delimiter
might be in the wrong place, causing the student record to end before
all data is entered. Check that surround characters are correctly placed.

For other ideas, see “Troubleshooting ASCII Transfer” on page 49.
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Importing Data

Import data only after you have made a backup of your Win School data
and have corrected any errors in your trial import.

Imported data is copied in the format specified by the import template from
the transfer file to the Win School database.

To import data:

1 In Windows, back up the Win School data folder.

2 In ASCII Transfer, open the Data List window of the import template,
and from the Import/Export menu, select Import.

 For data that is not students, teachers, courses, or rooms, go to Step 5.

3 For students, teachers, courses, or rooms, the Import Options dialog
appears.

 Sometimes the only active option is “Ignore new records.” The most
common reason for this is that you are importing data without student
names.

4 Indicate how to deal with records that have ID numbers the same as and
different from those in the Win School database.

New Numbers Start At Records assigned a new number get the
next free number starting with the
number you type in this field.

Add records and... “Skip
import records with
duplicate item numbers.”

Matching numbers are not imported.

Non-matching numbers are imported
with their existing numbers.
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Add records and... “Use the
item number and use a new
number for any duplicates.”

Matching numbers are imported and
assigned the next free number.

Non-matching numbers are imported
with their existing numbers.

Add records and... “Use a
new number for all
records.”

Matching and non-matching numbers are
imported and assigned the next free
number.

Update records and...
“Ignore new records.”

Matching numbers are imported and
imported data replaces existing
Win School data.

Non-matching numbers are ignored.

Update records and... “Add
new records using given
item number.”

Matching numbers are imported and
imported data replaces existing
Win School data.

Non-matching numbers are imported
with their existing numbers.

Update records and... “Add
new records using a new
item number.”

Matching numbers are imported and
imported data replaces existing
Win School data.

Non-matching numbers are imported and
assigned the next free number.

5 Click Import, then highlight the transfer file and click OK.

6 Print the Import Report and close the report window.

7 Check that the import is complete with no errors:

• Review the Import Report.

• If an import is complete, new records appear in the Data List
window.

• Start School Setup or Details and examine the new records for
incomplete or missing data.

Checking and Correcting Imported Data

To check for and correct errors in the imported data:

• If the problem is minor, correct the data in Details. For example,
student names usually contain a few errors.

• If the problem is serious, restore the backup data and check the
originating file and the template for inconsistencies.
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To remove imported data:

1 Make a note of some of the incorrect records and exactly what
happened with them.

2 If you added items without updating records, delete those items from
Details or School Setup.

 If you updated records and they have been damaged, restore the backup
data.

3 Perform a trial import and look for one of the damaged records you
noted. Compare the original import with the trial import to find the
source of the problem.

For solutions to specific problems, see “Troubleshooting ASCII Transfer”
on page 49.

Troubleshooting ASCII Transfer

Changing Case of Student Names

Use ASCII Transfer to export Student Number and Student Name into a
text file. Open the exported text file in a spreadsheet program or a word
processing program. Convert the Student Name column to the case you
want, initial capitals, all uppercase, or all lowercase. Import the corrected
text file back into Win School.

Entries with the Same Number when Teachers, Students, or Classes are Imported

At some point, records in the database that had the same ID number, were
deleted. Before you can reuse these numbers, Win School needs to run
Deletions Maintenance. Deletions Maintenance is run automatically when
you exit Win School Single-User.

In Win School Multi-User, you can force Deletions Maintenance by
shutting down and reloading the Win School Server. If you are unable to
shut down, wait for nightly maintenance. After nightly maintenance, you
will be able to import records with those ID numbers again.

“Ignore new records” is the only Option when Importing Student Records

Your template is missing either Student Name or Student Number. To
import a new student record to Details, you must have both the Student
Name and Student Number fields on the template.
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Imported Data in the Wrong Field

Check to see if this problem affects 1 or all records.

If the problem affects all records, change either the template or the text file
so they match.

If the problem affects 1 or a few records, change the records. In the table
below, for example, the data is offset by 1 field from the City field down.
The letter B should be in the same field as the number 456.

Student’s Physical Address 1 123 Main Street

Student’s Physical Address Apt. # (Import Only) 456

Student’s Physical Address City B

Student’s Physical Address State Los Angeles

Student’s Physical Address Zip Code CA

To change the records so both names appear in the same field:

1 Check the ASCII Transfer file to see if the data for the affected field
contains an extra delimiter or an extra empty data field.

2 Delete the extra delimiter or the extra data field in the ASCII Transfer
file so the 2 names appear in the same field.

Imported or Exported Data is Truncated

If imported or exported data is truncated a field length definition in the
template is incorrect.

1 Open the Edit Template window of the template.

2 Increase the field length definition for this field.

3 Run the trial import or export again.

Importing Student Grades doesn’t work with Student ID and Student Name

The template won’t work if you include both Student ID and Student Name.
Use one or the other.

Message “key value not present” on Importing Records

You get this message if your date format in the text file doesn’t match the
date format defined in the template. Change the date format in either the
template or the ASCII file so that two date formats match.
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Minimum Access Levels to Export Student Name and Phone Number

Access levels are in School Setup under Passwords. Choose System
Passwords and set the Details - Student access level to Change Only and the
Details - Personal Tab access level to Edit.

Record incomplete, half treated as the beginning of the next record

Look at the ASCII file with word processing program to diagnose the
problem.

In this example, ASCII Transfer found an additional character that it
interpreted as a record delimiter, in the Street Address field between 899-
3834 and 3453 Goose Ave.

Extra record
delimiter.

To correct the problem, delete the extra record delimiter, save the file, then
run the trial import again.
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Form Setup menu option, 17

Form Status menu option, 12

Form Status Report, 12

Format Setup menu option, 35

G
gender fields, transferring, 37

H
Historical information
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transferring, 38

I
Import menu option, 47

Import report, 48

importing data

checklist, 44

how to, 44, 47

incomplete records, 51

missing data, 50

off-set data, 50

trial import, 44

troubleshooting, 48

truncated, 50

verifying, 48

L
Load Template from Disk menu option, 32

loops

defined, 41

number of, 42

M
Mainframe Computers, 32

N
Name fields, transferring, 38

New menu option (Scanning), 13

new students, transferring, 36

New Template menu option, 35

O
Opscan scanner, 23

P
phone number, Technical Support, 1

Print Scan Forms menu option, 9

R
records

incomplete, 51

repeating groups

creating, 42

defined, 41

reports

Export report, 44

Form Status Report, 12

Import report, 48

Scanning Error Listing report, 11, 15, 18

Trial Import report, 45

Roster window

described, 4

S
Scan Errors window, 11, 15, 18

scan forms, 18

tips, 5

Scan Printed Forms menu option, 11, 15, 17

Scanform directory, 4

Scanner Setup menu option, 8, 12

Scanning

attendance data, 8

backing up data, 4

course requests, 17

multiple block classes, 8

overview, 3

student marks, 12

types of data, 2

what you should already know, 2

Scanning Error Listing report, 11, 15, 18

Scanning multiple block classes, 8

School Setup

transferring lists, 36

setting up

ASCII Transfer, 30

setting up Scanning



Win School Scanning and ASCII Transfer

Index  •  55

in other modules, 6

scanner, 7

tasks, 6

what you should already know, 2

Windows system, 7

Short Code (Import Only) fields, transferring,
36

Show ATD Status for PM menu option, 12

sorting items in a window, 34

Status Codes

transferring, 39

student marks, scanning, 12

T
Technical Support, contacting, 1

templates, 32

creating, 35

minimum requirements, 34

types of, 35

templates

adding fields, 43

timetables

transferring, 39

transferring data

methods, 30

trial import procedure

described, 45

verifying, 46

Trial Import report, 45

troubleshooting

incomplete data, 51

missing data, 50

off-set data, 50

truncated data, 50

U
User-Defined (Export Only) fields, transferring,

39, 40

User-Defined Fields and Flags, transferring, 39,
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W
website for Chancery, 1

windows (ASCII Transfer)

Edit Template window, 33

windows (Scanning)

Roster window, 4

Scan Errors window, 11, 15, 18


